
   

8.2.0 Release Notes 
The following notes describe changes on the 8.2.0 CD. Please 
read them carefully before you use your new software. The 
following applications have changed: 

! Accounts Payable 

! Accounts Payable�Australian 

! Address Book 

! Cash Management 

! General Ledger 

! Information Assistant 

! Inquiry Designer 

! Job Cost 

! ODBC 

! Project Management 

! Report Designer 

For information on previous releases, please refer to the 
following documents: 

! Release Notes for the 8.1.1 CD 

! Release Notes for the 8.1.0 CD 

! Release Notes for the 8.0.0 CD 
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Upgrade to the 8.2.0 CD 
Upgrade From an 8.x CD 

If you use an 8.1.0 or 8.1.1 CD, upgrade data files for the 
following applications after you install the 8.2.0 CD: 

! Accounts Payable (and Accounts Payable Australian) 

! Address Book 

! Cash Management 

! Inventory 

! Project Management 

! Purchasing 

If you use an 8.0.0 or 8.0.1 CD, upgrade data files for the 
following applications after you install the 8.2.0 CD: 

! Accounts Payable (and Accounts Payable Australian) 

! Address Book 

! Cash Management 

! Inventory 

! Job Cost 

! Payroll (and Payroll Australian and Canadian) 

! Project Management 

! Property Management 

! Purchasing 

! Service Management 

Upgrade From a 6.x.x or 7.x.x CD 

If you use a 6.x.x or 7.x.x CD, upgrade all data files after 
you install the 8.2.0 CD. 

The data file upgrade process can be quite lengthy if you 
have many large files. For more information, please refer to 
the TS-Main Help topic "Upgrading files." 
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Upgrade From a 5.4.x or Earlier CD 

If you use the software from a 5.4.x CD: 
1. Use File Doctor on all files to verify the integrity of your 

data. You cannot wait until after the upgrade to perform 
this check because 8.2.0 File Doctor is not compatible 
with software earlier than 6.0.0. 

2. Install the 8.2.0 CD and upgrade all data files. 

If you use the software from a CD earlier than 5.4.x: 
1. Use File Doctor on all files to verify the integrity of your 

data. You must use your current File Doctor program to 
perform this check before you upgrade to 5.4.x and 8.2.0 
in the next steps. 

2. Install a 5.4.x CD and upgrade all data files. 
3. Install the 8.2.0 CD and upgrade all data files. 

The data file upgrade process can be quite lengthy if you 
have many large files. For more information, please refer to 
the TS-Main Help topic "Upgrading files."  

IMPORTANT: Post all Property Management transactions 
before you upgrade from version 5.x.x to 8.2.0. Property 
Management cash receipts created in 5.x.x and posted in 
8.2.0 will not send information to the Cash Management 
application. 
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Accounts Payable 8.2.5 

Fixes 

Change Invoices 

Multiple operators can use Change Invoices at the same 
time. In earlier versions, only one operator at a time could 
use Change Invoices. 

Inquiries 

The condition Batch Source equals Import invoices was 
added to the AP Invoices by Batch inquiry. 

Invoice Entry 

A Project Management commitment must be released to 
accounting before you can enter the commitment on an 
Accounts Payable invoice. 
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Accounts Payable 8.2.5�
Australian 

Fixes 

Change Invoices 

Multiple operators can use Change Invoices at the same 
time. In earlier versions, only one operator at a time could 
use Change Invoices. 

Inquiries 

The condition, Batch Source equals Import invoices, was 
added to the AP Invoices by Batch inquiry. 

Invoice Entry 

A Project Management commitment must be released to 
accounting before you can enter the commitment on an 
invoice. 
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Address Book 8.2.9 

Compatibility 
To make existing Accounts Payable and Accounts Receivable 
records available in Address Book after installation, in TS 
Main, select Tools > Upgrade Files. The upgrade process 
creates Address Book contact records from Accounts 
Receivable and Accounts Payable in the Master.abm. 

If you use both accounting and estimating products, upgrade 
accounting data files before using the Estimating wizard (see 
below). If you upgrade Estimating first, you will not lose 
contact information, but you will have to resolve duplicates 
by hand. This could take a significant amount of time, 
depending on the size of your contact database. You need to 
upgrade accounting first only with your initial installation of 
Address Book.  

Estimating Tools provides a wizard to upgrade or convert 
your existing subcontractor records from various Timberline 
Estimating databases into Address Book contacts. The wizard 
also produces reports to help you resolve conflicts and 
duplicates in data. For more information see the Help topic 
"Integrating subcontractors into Address Book" on the 
Contents tab in Estimating Tools Help.  

For detailed information on upgrading to AB, see Upgrade to 
Address Book.pdf. You can access this file in the following 
ways: 

! When you install Timberline Office, in the Installation 
window, click Browse Documents. 

! After you install Timberline Office, start TS Main; then 
select Help > Documents.  

New Features 
You can now enter an extension to the business telephone 
number on the Person Setup window. 

Fixes 
You can now add new person contacts while creating a 
company and add a new company while creating a person 
contact. This functionality is available in Estimating, Buyout, 
Accounts Receivable, Accounts Payable, Project 
Management, and Address Book. 
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Cash Management 8.2.8 

New Features 

Edit Register 

You can clear transactions from the Edit Register window 
(Tasks > Edit Register). You can also clear up to 5 ranges 
of checks at one time in the Clear Checks window (Tasks > 
Edit Register > [Clear Checks]). For more information, 
see �Clearing entries� in Cash Management Help. 

Help Topics 

Help topics for Import Cleared Checks were enhanced. See 
�Import Cleared Check topics� in Cash Management Help. 

Fixes 

CM Settings 

Send detailed transactions to General Ledger has been 
changed to Create detailed transactions in General 
Ledger on the CM Settings > GL Information tab. 
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General Ledger 8.2.1 

New Features 

New Help Topic 

A Help topic about third-party import considerations was 
added. See �from a third party� under �import transactions� 
on the Index tab in General Ledger Help.  

Import Transactions 

You can import third-party transaction batches into General 
Ledger. See �from a third party� under �import transactions� 
on the Index tab in General Ledger Help. You must reset up 
any existing macros that include the Import Transactions 
task. 

NOTE: Enhancements to Import Transactions may impact 
any macros you currently use. You must reset up any 
existing macros that include the Import Transactions 
task. 
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Information Assistant 8.2.2 

New Features 

New Help Topics 

The following topics were added for the Project Management 
functions: 

! PJ Job Contract by Role function 

! PJ Last Job Used function 
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Inquiry Designer 8.2.2 

New Features 

New Help Topics 

The following topics were added for the Project Management 
functions: 

! PJ Job Contract by Role function 

! PJ Last Job Used function 
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Job Cost 8.2.0 

Compatibility 

Use Purchasing 8.2.0 and Inventory 8.2.0 With 
Job Cost 8.2.0 

Because of database changes in Job Cost 8.2.0, you must 
install Purchasing 8.2.0 and Inventory 8.2.0 to continue 
using the Purchasing and Inventory applications after you 
install Job Cost 8.2.0. 

New Features 

New Help Topic 

The Help topic, �When importing multiple jobs, only the first 
job imports,� is new with the release of Job Cost 8.2.0.  

New Forms 

Job Cost 8.2.0 contains two new change order forms that list 
approved change orders to date at File > Data Folder 
Settings > JC Settings > [Forms]. 

! JC Purchase Order CO Form 2 (CR).rpt 

! JC Subcontract CO Form 2 (CR).rpt 
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ODBC 8.0.32.204 

Compatibility 

IMPORTANT: Currently only Microsoft® Office 97, 2000, 
and 2002 (Access, Word, and Excel) are tested for 
compatibility with the Timberline ODBC driver. Timberline 
does not test for compatibility with any other products, 
including Microsoft Visual Basic for Applications (VBA), 
Microsoft ActiveX Data Objects (ADO), and Microsoft Data 
Access Objects (DAO). Although you may find success 
using another product, Timberline technical support can 
address only those issues and problems relating to the 
use of Microsoft Office (Access, Word, and Excel) to 
access data with the Timberline ODBC driver. 

For this release, Timberline tested ODBC compatibility with 
Office 97 on Windows 98 and NT 4. Timberline tested ODBC 
compatibility with Office 2000 on Windows ME and Windows 
2000. Timberline tested ODBC compatibility with Office 2002 
on Windows XP. 

Data Files 

The TS-ODBC driver is compatible with Timberline® Office 
data files. When you create Timberline data sources using 
ODBC Administrator 3.0, Microsoft Access, or Microsoft 
Query 8.0, note the items below. You can also read this 
information in the TS-ODBC Help topic �About creating 
Timberline data sources with ODBC Administrator v. 3.0 and 
MS Office.� 

! ODBC Administrator 3.0 and later allows a new data source 
to be created as a user data source name (DSN), a system 
DSN, or a file DSN. When you create a Timberline data 
source, you must create it as either a user or system DSN. 

A corresponding file DSN is created automatically when 
you set up a user or system DSN. 

! Microsoft Access allows a new data source to be created as 
a machine data source or a file data source. When you 
create a Timberline data source, you must create it as a 
machine data Source. A corresponding file data source is 
created automatically when you set up a machine data 
source. 

! Microsoft Query allows a new data source to be created 
only as a file data source. timberline data sources created 
from within Microsoft Query 8.0 do not provide access to 
Timberline data from Microsoft Query or any other 
application. Create new Timberline data sources from 
within the ODBC Administrator (see first bulleted item in 
this section). If existing Timberline data sources do not 
appear for selection within Microsoft Query, select the data 
source from within the ODBC Administrator. In the 
Timberline Data ODBC Setup window, click [OK]. A new 
file DSN entry generates automatically and is available for 
selection from within Microsoft Query. 

New Features 

Enhanced Help Topic 

ODBC 8.0.32.204 contains the following enhanced topic: Set 
up Driver Options. 

Shorten Field and Table Names Option 

Before ODBC 8.0.3, Timberline�s ODBC driver shortened 
table names longer than 36 characters and shortened field 
names longer than 25 characters. You can now create data 
source names (DSNs) that are compatible with reports you 
designed for versions of the software earlier than Accounting 
and Management Products 8.0.0 and Estimating Products 6.5 
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or compatible with reports you designed for Accounting and 
Management Products 8.0 and later or Estimating Products 
6.5 and later. See "Set up driver options" in the Help file for 
more information. 

Fixes 

Windows 98 and Windows ME 

In ODBC 8.0.32.130 (8.1.0 CD) only, if you used Windows 
98 or Windows Me to access accounting or estimating data 
through ODBC, the value �#deleted� could incorrectly 
appear. No data corruption occurred. ODBC 8.0.32.140 fixes 
this issue. 

SQL Operators and Property Management 

In 8.0.03 (8.0.0 CD) and ODBC 8.0.32.130 (8.1.0 CD), if you 
used the SQL operators �IN,� �BETWEEN,� �>=,� or �<=� to 
access date records in Property Management data, ODBC 
could omit records if the date equals the start date. ODBC 
8.0.32.204 fixes this issue. 

Database Access With a Program 

In ODBC 8.0.03 (8.0.0 CD) and ODBC 8.0.32.130 (8.1.0 
CD), if you wrote a custom program to access data, ODBC 
could return an error if the path to the data source exceeded 
68 characters. ODBC 8.0.32.204 fixes this issue. 

Job Cost Cost Code Custom and Job Cost Job 
Custom Fields 

In the previous version, if you tried to add records to the Job 
Cost Cost Code Custom or Job Cost Job Custom fields, 
ODBC could return the following error: �ODBC--insert on a 
linked table 'Master_JCM_Cost_code_Custom_Fields' failed. 

[Timberline][ODBC][DLL] I/O Error. Pervasive Status code 
46.  Access to the requested file is denied.� ODBC 8.0.32.204 
fixes this issue. 

Project Management Spec Section Description 
Field 

In the previous version, if you tried to change the 
Description field on the Project Management Spec. Section 
record, ODBC could return the following error: �Access 
denied.� ODBC 8.0.32.204 fixes this issue. 

Special Instructions 
This section includes special instructions regarding certain 
front-end applications and the TS-ODBC driver. Please read 
this section before you use the new version of software.  

Data Filenames in Microsoft Access and Microsoft 
Query  

Microsoft Access and Microsoft Query place limits on the 
length of table names. To determine the length of a table 
name as seen from an application, count each character in 
the table name as it is displayed in the application. Count 
each underscore character ("_") twice. If the number of 
characters is over 63 for Microsoft Access or over 65 for 
Microsoft Query, the table name is too long. Table names 
that exceed the allowed maximum number of characters will 
be inaccessible from Access or Query. If you find any table 
names that are too long, rename the data file that contains 
the table to a shorter name. 
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Invalid Entry Error Associated With Microsoft 
Query 

If you try to create Timberline records using the Query 
window in Microsoft Query, you may receive the message 
"Invalid Entry." This message appears if the TS-ODBC 
driver detects that a field in the record you are trying to 
create contains either an invalid entry or no entry. To resolve 
this problem, create your Timberline records from Query 
using an SQL statement. Refer to your Microsoft Query 
documentation for more information about creating SQL 
statements. 

Microsoft Patches That Affect ODBC 

Microsoft frequently releases patches for its Office products 
that could affect how Timberline's ODBC driver works. For 
more information about Microsoft patches, refer to the Web 
site http://officeupdate.microsoft.com. 

Updating ODBC Links When Column or Field 
Names Change 

If any column headers or field names change in an 
application, remember to update the SQL statements that 
relate to those columns or fields. For example, if you change 
a field name using Custom Descriptions (File > Company 
or Data Folder Settings), you also need to update all ODBC 
links that use that field. 
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Project Management 8.2.26 

New Features 

New Help Topics 

Two new topics explain PJ functions that are available when 
you create PJ reports in Report Designer. The PJ Last Job 
Used function is also available in Crystal Reports. 

! PJ Last Job Used function 

! PJ Job Contact by Role function 

All Documents (Documents Menu) 

A [Print Preview] button has been added to the print 
selection window for documents. You can now preview a 
document by clicking [Print] in the document window, and 
then in the print selection window, click [Print Preview]. 

In a document window, you can type an existing job's 
number (with or without punctuation) or description directly 
into the Job field to bring it into view.  

The Contact Selection window in which you choose a 
person or company contact now opens with the Person 
View selected instead of the Job Contact List. 

Check Spelling 

With the check spelling feature you can check certain fields 
for misspelled words. For a list of PJ fields that have check 
spelling capabilities and instructions on how to check 
spelling, see the Help topic titled "Where you can check 
spelling in Project Management." 

Drawing Log (Documents Menu) 

Use the drawing log to track drawings, revisions, and 
sketches over the life of a project. You can quickly identify 
the most current drawings to ensure that all project 
participants are building the project as planned, using the 
most current revisions. You can easily access drawing history 
information to see to whom you sent drawings and when you 
sent them. For more information on using the drawing log, 
click [Help] in the lower right corner of the Drawing Log 
window, or see the Help topic titled "Drawing Log workflow." 

Meeting Minutes (Documents Menu) 

Meeting minutes provides a way to record meeting 
attendees, issues, events, and action items that you discuss 
in your project meetings. You can track issues from one 
meeting to the next, record an ongoing series of events 
about a particular issue, track who is responsible for the 
issue, and close issues when they are resolved. You can print 
meeting minutes and agendas and send copies of meeting 
minutes to all participants by e-mail, fax, or paper. For more 
information on using meeting minutes, click [Help] in the 
lower right corner of meeting minute windows, or see the 
Help topic titled "Meeting minutes workflow." 

Inquiries (Inquiry Menu) 

New inquiries: 

! Drawing inquiries  (Inquiry > Drawing) 

! Meeting minute inquiries  (Inquiry > Meeting Minutes) 

! RFIs by Contact  (Inquiry > RFI) 

! Transmittals by Contact  (Inquiry > Transmittal) 



Release Notes�Project Management 8.2.26 16 of 17 8.2.0 CD 

Reports (Reports Menu) 

Custom descriptions are now included in PJ reports and 
document forms. 

The Request for Information submenu on the Reports 
menu was changed to RFI. 

An Include closed jobs check box was added to the print 
selection window for many appropriate reports. 

New Reports 

! Drawing reports  (Reports > Drawing) 

! Meeting minute reports  (Reports > Meeting Minutes) 

! RFI Log as of Date (CR) and RFI Log as of Date  (Reports 
> RFI) 

! Subcontractor List (CR)  (Reports > Job Contact Lists) 

! Change Orders Not Released  (Reports > Change 
Management) 

Revised Reports 

! RFI Log with Detail (CR) and RFI Log with Detail now 
include drawings (Reports > RFI). 

! Document Distribution (CR) now includes meeting minutes 
and drawings (Reports > Other). 

! Dunning Letter-Overdue (CR) now includes meeting minute 
items (Reports > Other). 

! Overdue Documents (CR) now includes meeting minute 
items (Reports > Other). 

RFIs (Documents > RFIs) 

When you click the binoculars icon beside the Drawing field 
in the RFI window, you can select one or more drawings 

from a list of drawings that were entered in the drawing log 
(Documents > Drawing Log). 

RFI numbers sort in a new way. For example, in the Find 
RFI window, you will see numbers sorted as 1, 1.1, 1.2, 2, 
2.1, 3, and 3.1, rather than 1, 2, 3, 1.1, 1.2, 2.1, and 3.1. 

RFI numbers now increment for sections. For example, if the 
last RFI number entered was 7.4, it automatically increments 
to 7.5 when you enter a new RFI. 

When you create a transmittal for an RFI, the transmittal's 
Urgency prefills with the RFI's Urgency. 

Transmittals (Documents > Transmittals) 

The following windows were changed to make it easier to 
select from the lists: 

! Select Change Orders for Transmittal window 

! Select Commitments for Transmittal window 

! Select Commitment Change Orders for Transmittal window 
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Report Designer 8.1.4 

New Features 

New Help Topics 

The following topics were added for the Project Management 
functions: 

! PJ Job Contract by Role function 

! PJ Last Job Used function 
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